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Abstract

YoNav is a real-time navigation and data acquisition program written in Microsoft C/C++ that provides
navigation services on almost any DOS platform. The YoNav Graphical User interface (GUI) supports
virtually any VGA and most EGA graphics hardware. In its fullest configuration, YoNav will support up to
10 simultaneous serial RS232 channels, 4 channeis of digital /O, live video dispiay and frame capture
from 3 types of video input and graphic support for over 150 different printers. The same software will
aiso operate on a notebook PC with only one or two serial inputs. YoNav is completely configurable by a
small utility YoCfg that allows various pieces of optional hardware to be configured in or out of the
system. Data can be logged in either or both a compact binary or standard USGS ascii format on any
system disk. Post-plotting of binary format navigation data can occur while data is still being acquired
through a multi-tasking time slice process.

introduction

During the winter of 1991, the USGS Marine Facility began development of a portable
PC based integrated navigation system that would replace the aging navigation
RhoRho 2system currently in use. One of the driving factors for a new navigation
system was the completion of the GLORIA Exclusive Economic Zone (EEZ) work and
the termination of the lease of the R/V Famella which had been the primary research
vessel for marine operations since the late 1980's. The RhoRho system had been
designed mainly to provide steering displays and navigation services to the GLORIA
project on a ship that always had the same sensors, heimsmen and navigators. With
the acquisition of a new vessel on the horizon, it became apparent that we needed a
navigation system that could be portable, work with many different navigation sensors
and have a modern graphical user interface that is both intuitive and easily learmed by
less experienced watchstanders. This paper describes and documents the operation
and setup of this system known as YoNav.

2Gann, John T., 1988, Integrated GPS, Range-range and Hyperbolic Loran C Marine Navigation
System for Use on IBM AT or Compatible Microcomputers, USGS Open File Report 88-562, 39
pages
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Main Graphics Display

The main graphics display is comprised of 4 different windows: 1) the main
drawing area, 2) the side panel display, 3) the scrolling message area in
the lower right comer and 4) the status bar at the bottom of the main
drawing area display. Each part of the display serves a discrete function.
Please refer to Figure 1. while reading the next few sections.

ain Area
The main drawing area displays a plan view of the ship's location, survey
lines, sampling sites and other symbology that the user can specify. See
Figure 2,
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Cursor Coordi

3
37 38.56459' N 122 1263858' W (Scale: 212 )

o Figure 2. Main Drawing Area

The main drawing area is updated once per second as long as there is not
a menu or some other form that would obstruct the drawing. Exactly what is
displayed is controlied by the Display Main Menu choices. In this display,
north always points to the top of the monitor. The gyro or course
information is used to orient the ship symbol to the proper rotation.



Side Panel Display

The side panel display shows the numerical values that are represented
pictorially in the main graphics display window. See Figure 3.
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Figure 3. Side Panel Display
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Starting from the top of the display, the operator is presented with a series
of display only fields that are updated once per second, regardiess of what
is happening on the graphics display. Time is displayed as Day of Year
followed by the current hour, minute, second and thousandths of seconds.
The time displayed is taken from the system clock. (When a GPS sensor is
in use, please note that system time is synced to GPS time at regular
intervals).

Time & Position
Next displayed are two fields containing the Y and X coordinates of the
Vessel Reference Position (VRP). The VRP is defined under the
Edit/Vessel/Reference menu selection. The VRP may be displayed in
either latitude longitude coordinate system or in a Universal Transverse
Mercator (UTM) coordinate system. The user may specify the units for both
coordinate systems. See menu selection Config/Coordinate System and
Config/Units. Under the X coordinate are two fields on the same line. The
first field is the current depth. The next field is the currently selected
navigation sensor. The depth is displayed in meters only when the
Raytheon PDD Bathy 2000 depth digitizer is connected. Other depth
digitizers may be integrated in future releases. The displayed depth is valid
unless followed by an asterisk. The asterisk indicates that the alarm light
was lit on the PDD 2000 when the current depth was read. The current
sensor is the sensor that is chosen to compute the line and site distances
from. This sensor can be selected under the menu pick
Edit/Sensor/Select Nav Sensor.

Vessel Dynamics
Under the current sensor field are 3 fieids that describe the dynamics of the

vessel to the left and 3 fields that describe the vessel relative to either a
survey line or a sampling site depending on what the operator has
requested for display. The field labeled "SMG" is the computed speed
made good displayed in knots. This value is computed based on the filter
settings controlled by menu selection Edit/Sensor/Filter. The speed and
course filters are a logarithmic filter with a user specified time constant.
The field labeled "CMG" is the computed course made good of the vessel.
The same filter function is applied to this value. The field labeled "HDG"
represents the vessels heading when a gyro or compass is available. if no
gyro source is available this field will display the computed course made
good.
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Trackli istances

The trackline distances are described by three fields that are to the right of
the vessel dynamics fields. The topmost field labeled "CRO" is the cross
track distance. The cross track distance is the distance measured
perpendicular from the survey line to the vessel. Positive values indicate
that the vessel is to the right of the survey line and negative values indicate
that the vessel is to the left of the line. The field labeled "ALO" is the along
track distance. The along track distance is the distance traveled parallel to
the survey line. Negative values indicate that the vessel has not yet
reached the start of line point. All distances are displayed in meters. The
field labeled "END" is the distance remaining to the end of the survey line
measured paraliel to the line.

Sampling Site Distances

When the user has selected to display the site mode instead of line mode,
the side panel will display range and bearing information instead of
trackline distances.

The field labeled "RNG" contains the range in meters from the vessel
location to the currently selected sampling site. To select a sampling site
see Edit‘Sampling Sites.

The field labeled "BRG" displays the current bearing from the vessel to the
sampling site. This is the course that the heimsman should steer to hit the
site.

The File Menu
The File Menu contains selections for configuring the data logging, printer

setup and exit functions. Each menu selection and its associated forms will
be discussed in sequence.

Logaing
The Logging menu selection allows the operator to select both the format
and disk drive upon which to record the navigation data. By selecting the

Log Disk Drive field, the operator can choose the physical disk drive. See
figure 4.

11
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Figure 4. Data Logging Setup Form

There are two check boxes on the Logging form that allow the operator to
select exactly what will be logged to the disk. By selecting the Enable
Binary Logging option, YoNav will record all raw data from each enabled
sensor as specified in the Edit/Sensor/Port Assignment form. Note that
the logging interval for binary logging is specified in the Edit’/Sensor/Port
Assignment form not in the Logging form. The reason for this is to
provide the operator will as much flexibility as possible. Since some
sensors may be reporting large amounts of data relative to others, the
operator may tailor the recording rates of each sensor to their particular
requirements. The Enable Ascii Logging check box enables the recording
of the currently selected navigation sensor only in an abbreviated standard
Ascii format used by the USGS navigation data processing group. Since
only one sensor can be the primary sensor, this form provides an interval
entry field. Specify the number of seconds between each successive
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recording interval. See Appendix A. for both binary and ascii data
recording formats. The Help button at the bottom of the form contains
useful operator tips that about the logging feature, that may be more recent
than this manual. The operator may aiso add comments of their own to this
help file by editing the ascii file named logdata.hip. The Okay button
accepts the form changes and exits the form. The Cancel button aborts the
form.

Select Disk Drive

08 M9 (2 B0 (e

Figure 5. Log Disk Selection Form

Printer Configuration

The Printer menu selection allows the operator to enable/disable and
select the printer to be used for graphic screen dumps and regular printer
logging of navigation data. The printer is enabled by checking the Printer
Enabled check box. The interval between successive routine navigation
printouts is specified in minutes in the field labeled Print interval
(minutes). The field labeled Width/Columns specifies the width of a
printed line in characters. The field labeled Height/Rows specifies the
number of lines per page for printouts. See Figure 6.
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On or Off

uration

i tqr ofi

i Print Interval (minutes) Printout Interval

Width/Columns 3@ | Height/Rows |6f3

Horizontal Scale lz.sl | vertical keale |2.5| '

Printer !HP PaintJet 16 Colors —
| I Cancel

Page size

Graphic Scaling
Active Printer

Abort this form

Accept & exit

Figure 7. Printer Setup Form

The Printer Setup form allows the operator to configure YoNav to operate
correctly with a particular printer. See Figure 8. The two scaling fields
labeled Horizontal Scale and Vertical Scale are used to scale the
graphical image on your particular printer. These two fields only affect the
screen dumped printed image. The operator uses these two values to
stretch or shrink the printed image in either the horizontal or vertical
direction. You will need to experiment with these settings to get the desired
size.
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, | Select a Printer
Acer LP-76
Acer LP ?6

AEG Olgmpia 24-pm Hodels (B/w)

AEG Olympia Laserstar 6
Alps B-pin Models (B/W)

Alps B-pin Models (Color)
Alps 24-pin Models (B/W)

| ocey § oerault § concel § telp |

Figure 8. Printer Selection Form

By selecting the field labeled Printer, the operator is presented a list of
possible printers that can be supported by YoNav. Select the printer that
matches yours and press the Okay button. See Figure 8.

Change Diskette
By selecting the Change Diskette option, the operator can close the

navigation log files on the logged diskette and insert another pre-formatted
diskette into the disk drive. This function will detect if the current Log Disk
is removabie media. If the log disk is the hard drive or some other non-
removable media, YoNav will display the error message "Non-removable
media" and continue logging. Note that only preformatted diskettes should
be used with YoONav. Never remove a floppy diskette from the drive when
that floppy is selected for logging. If you need to remove the diskette, you
must first stop data recording. Data recording can be disabled by using
the File/Logging menu selection.
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Exitt
The exit function closes ail data logging files, disables serial interrupts,
restores the text mode and returns the computer to DOS.

The Edit Menu

The Edit menu allows the operator to configure the system to their
particular needs. The operator may configure the sensors and sensor
related features, setup survey lines, configure the UTM parameters,
describe the vessel, and configure sampling sites.

File ngtilmes Display Config

Select for Nav
Port Assignment

Lines

Geodesy celect &
- mmi Vessel Ne ec __t_gro
Sampling Sites év Stations
- Filter Constants

Calibrate Range Sys

Figure 9. The Edit Menu

Edit Sensor Menu

The Edit Sensor menu allows the operator to configure the sensors and
their related parameters.

Select for Nay :
The Select for Nav menu allows the operator to select the sensor that will be used to

compute steering information to lines and sampling sites. See Figure 10.
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Select Active Sensor
COM2 Trimble NavTrakil Wz

COM2 Trimble NavTrakii

i
to

BFigure 10. Select for Nav

. When a sensor that can provide full steering information has been
enabled, it will appear in the list presented by the Select for Nav form. To
select a sensor for steering select the name of the sensor so that it appears
in the top line of the form, then select Okay. Note that selecting a sensor
for steering has no effect on the binary logging function. If binary logging is
enabled, then all sensors that are enabled will be logged at the specified
frequency. Select for Nav does however affect what is logged in the ascii
data log file. Only the sensor that is being used for steering will be
recorded in the ascii data log file.

Port Assignment
The Port Assignment menu allows the operator to assign each serial

sensor to a specified serial port. See Figure 11.
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Select Parameters for COM1

Log/Xmit Intekval (sec) [Z’

|vfDisable

Sensor Baud
N HP Compatible Plotter Iv ;AI 9660 Izj
Handshake
Parity  Data Bits Stop Bits

XON/XOFF
CTS/RTS]|
DTR/DSR

COM1: 9606, N, 8, 1

, Cancel I

e -

Figure 11. Port Assignment

Each serial port in the system can be described by the use of the Port
Assignment form. The port that is being configure by this form is indicated
at the title area of the Port Assignment form, e.g. "Select Parameters for
COM1". The user may Enable/Disable a serial port by checking either the
Disable or Enable box on the Port Assignment form. When a port is
disabled, any input that appears at that port will be ignored. [f the port is
enabled, then YoNav will attempt to read and parse the incoming data
using the RS232 parameters contained on this form. The field fabeled
Log/Xmit Interval (sec) contains the interval in seconds between either
successive binary data logging or serial data transmissions for this sensor.
Some sensors such as Mudshark, are write-only sensors, i.e. these sensors
are only sent navigation data, they do not provide it. By setting the
Log/Xmit Interval field, the operator can control how frequently a write-only
sensor will be updated. In contrast, any sensor that provides navigation
data can have all of its data recorded in a compact binary format. The
Log/Xmit Interval will control the logging frequency of these sensors as
well. The field labeled Sensor contains the name of the current sensor that
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is assigned to this port. This field has 2 arrow buttons on either end of it.
By selecting either of the arrows, the operator can scroll through the list of
possible sensors that YoNav supports. When the appropriate sensor is in
view continue by configuring the RS232 parameters for that particular
sensor. The Handshake buttons configure the type of handshake protocol
used by the selected sensor. All of the currently supported YoNav sensors
will work with no handshake. The Parity buttons should be set to reflect
the parity of the sensor. The Data Bits buttons should be setto 7 or 8
again to match the sensor. The Stop Bits button should be set to 1 or 2 to
match the selected sensor. Finally, the baud rate must also match the
sensor. Select the baud rate by selecting the arrows at the end of the field
labeled Baud. There is a non-selectable field directly below the Data Bits
field that shows the current RS232 settings. If the current port is not the
port you wish to modify, you may select either the Next or Previous buttons
to advance or retard the port. If you are satisfied with the port settings you
may select either the Okay or Save buttons. The Okay button will keep the
changes you have made and return you to the previous menu. The Save
button will keep the changes you have made and allow you to modify other
port assignments. The Cancel button will allow you to bail out of the
current form without saving any changes.

Select Gyro
The Select Gyro menu allows the operator to assign a sensor as the

source of ship's heading data. Some sensors may interface directly to a
ship's gyro through a synchro to digital or stepper to digital board. These
sensors may then provide this heading information directly to YoNav. The
Select Gyro form lists all of the sources of heading information that YoNav
is currently interfaced to. See Figure 12.

19



Select Gyro Source

,--l Magnavox 1187
! ﬂ KVH
pfﬁ_B_uster Gyro Digitizer
pom

H i_lgo Gyro - Use Course
' Okay l i Cance!l

Figure 12. Select Gyro Source

Nav Stations

The Nav Stations menu allows the operator to set up locations and
transponder info for shore based navigation beacons such as the Del Norte
Model DDMU540. See Figure 13.
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Station 1 of 18

VI Enabled
Station Name luses Marine Facility |

1. Latitude r37 30.45606' N |

2. Longitude Fﬁ
Height F;W
Transponder Id rB—r:)T-
Range Bias E
Lgkay ! LF;rovious | Next I | Cancel ' ! Save ’

Figure 13. Nav Stations

The Nav Stations form contains an Enabled check box which enables the
station for use. If a station transponder is received, but the transponder is
not enabled, that station will be ignored. Up to 10 stations may be in use at
any time, although only 4 stations at a time have been tested. There is a
field labeled Station Name which can be modified to contain a descriptive
name of up to 30 characters. The Latitude and Longitude fields shouid be
entered in WGS-84 coordinates. The Height field should contain height of
the transponder antenna above sea-level in meters. The height of the
antenna is used to correct the slant range received from the ranging
receiver. Be sure that the Del Norte receiver does not also correct for
height of the transponder by placing zeroes in the receiver field for height.
The Transponder ID field should contain the 3 digit Del Norte transponder
code that matches the transponder installed at this location. The Range
Bias field should contain 0.0 unless you have information about a range
error with this transponder. The Range Bias field allows the operator to
enter a bias value in meters to be applied to the observed range during the
least squares reduction. If the current station is not the one that you wish
to modify you may select either the Next or Previous buttons to call up the
next or previous station. To save the changes on this form you may select
either the Okay or the Save buttons. The Okay button will apply the
contents of the current form and exit. The Save button will apply the

21



contents of the current form and select the next station in the list. The
Cancel button exits the current station form without saving any changes.

ilter Con
The Fiiter Constants form allows the operator to set up a smoothing and
time constant filter that is used for course and speed calculations. The
Filter Time Constant field is the length of position history that will be used
to compute course and speed. Longer the filter times result in more
dampened response times. The Filter Smoothing field is the relative weight
given to the current observation. The higher the smoothing constant the
more weight that will be applied to the current observation. See Figure 14.

Filter Setup

Filter Smoothing (1-1608) }56

- - o

Figure 14. Filter Constants

Calibrate Range System
The Calibrate Range System form allows the operator to troubleshoot and

calibrate the Del Norte 540 system. See Figure 15.
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0000

1000
| 0000

Figure 15. Calibrate Range System

To start the calibration procedure, select the Calibrate button. Each
station's name, transponder ID and observed range is displayed as it is
received by YoNav. Then using the currently selected navigation sensor
as truth, a theoretical range to each station is computed. The difference
between the theoretical range and the observed range is displayed in the
C-O (computed minus observed) column. Kf the C-O values are higher than
a few meters it may indicate that a station coordinate has been entered
incorrectly. If this is the case, check the navigation station coordinates and
reenter if necessary. When satisfied with the results select the Done
button. If you wish to use the current C-O values as Range Bias values in
the least squares solution, then select the Accept button.

Edit Line Menu
The Edit Line Menu selections allow the operator to Add, Edit, Delete, List,

Select and Generate survey lines.

Add Lines
The Add menu selection allows the operator to add individual survey lines
to a list of survey lines. See Figure 16.
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Line Entrg Form

Line Name lH41 | l

Starting Ending

1. Lat §37 36.99658' N 3. Lat |37 38.99858" N
2. Lon !122 1261999' w . | 4. Lon !122 14.88680" W

Range § 2833.7 Bearing !Z?B.B
| S oo
| Defaultl : Cancel

Figure 16. Line Entry Form

The operator may provide a name in the Line Name field that may be up to
30 characters in length. The starting and ending coordinates can be
entered in either UTM or latitude longitude coordinates depending upon the
selected coordinate system. The range and bearing of the line are
computed when the Okay button is selected and the line is added. The
Flip button can be used to make the starting coordinates become the
ending coordinates and vice versa. To abort the operation press the
Cancel button.

Edit Lines
The Edit Line menu selection allows the operator to edit individual survey
lines. See Figure 17.
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Figure 17. Line Edit Selection Form

The operator may select the line to be edited by highlighting the desired
line and pressing the Okay button, or may elect to cancel the editing
operation by selecting Cancel. If a selection is made, a line will be
presented using the Line Entry Form above. All edits can be made as
described in the above section on adding lines.

Delete Lines

The Delete Line menu selection aliows the operator to delete some or all of
the survey lines See Figure 18.
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Select Lines for Deletion

Marfac
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RBS
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Figure 18. Line Delete Selection Form

The operator may check individual lines for deletion by clicking on the
desired line name or all lines may be selected for deletion by selecting the
All button. No lines can be selected for deletion by selecting the None
button. To abort the operation select the Cancel button. To execute the
deletion select the Okay Button

List Lines

The List Line menu selection allows the operator to display and optionally
print an ascii list of all of the currently entered survey lines. See Figure 19.
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Marfac

Starts: 37 36.86880° N 122 12.66800° W
Ends: 37 35.680806' N 122 12.66680' W
Range: 9248.2

R

Starts: 37 30.45688' N 122 12.61998' W
Ends: 37 30.45860' N 122 14.860600' W
Range: 2833.7

Figure 19. Line Display Form

The user may print the contents of this form by selecting the Print button.
When finished viewing the window, select Okay button.

Select Line

The Select Line option aliows the operator to select the survey line that will
be displayed on the Side Panel display and the Bridge Display if one is
active. The selected line is chosen by highlighting the desired line and
pressing the Okay button. The Cancel button will abort the line selection
procedure. See Figure 20.
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Figure 20. Select Line Form

Line Generator

The Line Generator option allows the operator to automatically generate
regular line coverage for a specified area. The operator defines a Root

Line around which lines will be generated at user specified spacing and

bounded by a user specified limit. See Figure 21.
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Line Generator Setup

Root Line
Starting Ending

1. Lat ,BB 66.60800° N 3. Lat |BB 66.06066° N
2. Lon 'agg 66.66060° E 4. Lon lBElB 66.8660800' E

Line §pacing (m) {06 | Generate lines to ...

- _Jeert

Bounding Limit (m) }0.8 . -—-W.

gseneraten Done I l View '?Accept I ”,,",-,.,;IB“h

Figure 21. Generate Lines Form

The root line coordinates are entered just as they are in the Line Entry
Form. Each line that is generated will be parallel to the root line. The Line
Spacing field determines the separation between each line. The
Bounding Limit is the perpendicular distance from the root line to the
outermost survey line. Thus the Bounding Limit field controls the area
width for which lines will be generated. Lines may be generated either to
the left or right or on both sides of the root line by selecting the appropriate
check box in the Generate Lines To Field. To actually generate the lines
select the Generate button. To view or print the lines that were generated,
select the View button. To attach the generated lines to the list of survey
lines that YoNav can select from, press the Accept button. To exit the line
generation form select the Done button.

Geodesy Mend

The Geodesy menu currently only contains one option that allows the
operator to set up a default UTM zone for grid line computations. The UTM
grid zone number is used in line calculations that span across two UTM
zones. See Figure 22.
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UTM Zone Number E

UTM Zone Letter E!

Figure 22. Default UTM Zone

Edit Vessel Menu
The Edit Vessel menu provides the operator the means to define the shape

of the vessel and to specify the location of navigation sensors relative to
the user specified vessel reference location.

Vessel Shape

The Vessel Shape selection allows the operator to select among various
vessel outlines, that will be the graphic icon that represents the ship. See
Figure 23. for an example of shape files to choose from.

®Select Shape File

SIDESCAN.SHP

SIDESCAN.SHP
BUGGY.SHP
SEISMIC.SHP
SI|MPLE SHP
BAT_BOAT.SHP

Figure 23.Select Vessel Shape
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Vessel Offsets
The Vessel Offsets selection aliows the operator define the exact location

of various shipboard sensors relative to some defined reference position,
usually the center of motion of the vessel. By defining the offset of each
sensor on the ship, any sensor can be used to determine the location of the
bow, stern hydrophone or any other point very easily. The coordinates for
each sensor are entered in relative meters of offset from the user defined
reference position. See Figure 24.

Sensor Qffsets
Relative to Vessel
Reference Position

Sensor
AI Northstar 7000 Loran]V]

DY
l3.1

Figure 24 Vessel Offsets

| Reference Position

The Vessel Reference Position selection aliows the operator define the
position on the vessel to which all sensors will be referenced. Normally,
this will be the center, bow or stern of the ship. See Figure 25.
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Vessel Reference Position
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Figure 25.Vessel Reference Position

Sampling Sites Menu

The Sampling Sites menu selection allows the operator add, edit, delete,
select and list the sampling site location list. Sampling sites are defined by
a geographic position. They can be used as way points to steer to in a
range and bearing mode. To Add a site, select the Add option under the
Sampling Site Menu selection. See Figure 26.

Add Sites
The Add Sites menu selection presents the user with the Site Entry form.

See Figure 27.
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Site Name ]Site BS

1. Latitude IBE 37.88819' N

2 Longitude [121 $2.58245' W

' Depth IE).B
Sample Type
;: ﬂnisplag i~} Box Core

| Okay | {pefault] [cancel] | | Video |

Figure 27 .Site Entry Form

info l

To enter the name of the site select the Site Name field. Site names may
be up to 30 characters in length. The position may be entered in the
current coordinate system. See Appendix B for a description of coordinate
entry. The Depth field is only used for annotation purposes. A square
symbol may be used to indicate the sampling site on the graphic display.
To have the symbol displayed, check the Display check box. The sampling
type may also be logged by selecting among the various sampling types in
the Sample Type list. When the Site Entry form is complete, you may save
the entry by pressing the Okay button. The Cancel button aliows the
operator to abort the site entry form at any time.

Edit Sites

The Edit Sites menu selection allows the user to select a site entry to be
edited See Figure 28.
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Figure 28.Edit Site Selection

The Site Selection form allows the operator to select which site to edit.
Select Okay once the desired site has been selected. Select Cancel to
abort the site editing process. If the operator selects a site for editing, the
Site Entry form will be displayed with the requested site entry. The
operator may change any of the site form parameters as discussed above
in the section on Add Sites. The Info button will display any Logbook
comments that may have been entered during the time that this site was
selected as the current site. (See the section on logbook entries under
Utilities/Logbook). The Video button will recall any video images that were
recorded during the time that this site was the active site. (See also
Display/Video for a discussion of saving video images).

Delete Sites

The Delete Sites menu select ion allows the user to select one, some or all
of the site entries for deletion. When all but a few sites need to be deleted,
the best way to do it is to select the All button to flag all of the sites. Then
toggle off the sites that are not to be deleted. A site will be deleted when
there is a check mark beside it. To clear all of the check marks, i.e. delete
no sites, select the None button. To abort the delete operation select the
Cancel button. To execute the deletion of the checked site entries select

the Okay button 29.
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Select Sites for Deletion

Figure 29.Delete Sites Selection

lect Site
The Select Site menu selection aliows the operator to select the site that the vessel is
attempting to steer towards. If the Side Panel Display is displaying site information
then the newly selected site will be the site referenced. Selection of a new site will
affect the display on the bridge if the bridge display is active and in site mode. Select
the active site by selecting the name of the desired site and pressing the Okay button
See Figure 30.

@ Select Site For Steerirk

Rsito ot B~
§ Site 01 E

| Site 82
Site 83
Site 84
Site 85

Figure 30.Select Active Site
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List Sites

The List Sites menu selection allows the operator to view and optionally print a
formatted ascii list of the current sampling sites. To print this list select the Print
button. When finished viewing this display select the Okay button or press the Esc
key. See Figure 31

’ Name: Site 81
jPosition: 37 38.45608' N 122 12.61998" W
8 Depth: 8.0

Type: Box Core

Name: Site B2

Position: 37 38.60680' N 122 12.660080" W
8 Depth: 8.0
Type: Box Core

Figure 31.List Sites Display

The Utilities Menu

The Utilities menu selection allows the operator to perform various utility tasks without
affecting the real-time navigation function. These utilities include range and bearing
between two points, inverse calculations, UTM to latitude/longitude conversion, a
general logbook entry form and a post plotting utility. The coordinates used in the
utility functions are saved so that on subsequent invocations the last coordinates you
used will still be entered in the utility forms.

Range/Bearing

The Range/Bearing menu selection allows the operator to compute the range and
bearing between two points. Calculations are performed on the ellipsoid using WGS-
84 for the defining parameters. See Figure 32.
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Figure 32.Range/Bearing Utility

The range and bearing can be computed by entering the starting and ending
coordinates as described in Appendix B. Entering Coordinates.

When the coordinates are entered correctly, select the Calculate button to compute the
range and bearing. Select the Done button when finished.

inverse Computation

The Inverse Computation menu selection allows the operator to compute the new
endpoint that is projected at a user specified range and bearing away from a user
specified position. The results will be displayed in the current system coordinates. All
computations are done on the WGS-84 ellipsoid. See Figure 33
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Figure 33 Inverse Utility

To set up the computation, enter the latitude and longitude of the start point as
described in Appendix B: Entering Coordinates. Next enter the range in meters for
the desired endpoint. Then enter the bearing in degrees clockwise from north of the
desired endpoint. When the form entry is complete, select the Calculate button. The
results of the calculation will appear as shown in Figure 33

LogBook Entry

The LogBook Entry menu selection allows the operator to record comments that may
be pertinent to post processing of the cruise data. Such information might include sea
and weather conditions, maneuvering for traffic or obstructions, progress and results of
sampling efforts and system problems. See Figure 34

LogBook Entr

IBox Core In Water
l‘ Okay ' | Cancel l

Figure 34.LogBook Entry
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To enter a LogBook entry, just begin typing your entry. There is no need to enter the
time or system position since YoNav provides that for you. When you are finished with
your entry, press the Okay button to record it. All logbook entries are saved in an ascii
file named LOGBOOK that is recorded on the Log Disk. (See section on
File/Logging). If the printer is enabled and on line, the logbook entry will aiso be sent
to the printer. To enter a logbook entry at any time, the F1 key may be pressed. This
key is provided as a short cut to selecting the menu item.

Post Piot Nav Data

The Post Plot Nav Data menu selection allows the operator to generate a screen or
piotter dump of the binary log file for any recorded sensor. This feature continues as a
background operation and does not inhibit real-time data acquisition in any way. See
Figure 35

— PostPlotSetwp

Stop Plotting

Scale

1. Center Lat §37 36.458008' N
 SELTEL R SR LA S TR
2. Center Lon §122 12.62988" W

Filename JC:\USGS\NAV\bin_nav.log

Plot Track From 7
al Trimble NavTrakll i<l

P:/E Screeni I Plotter
I‘ Okay I ! Cancell

Figure 35.Post Piot Nav Data
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To plot navigation data, you must be recording the binary data for the sensor you wish
to plot.

The Post Plot Setup form allows the operator to specify the time interval between
successive plotted points in the field iabeled interval (sec).

To plot every position recorded for a given sensor enter a 1 for the interval. The
operator may enter a start and stop time for the times of interest. Positions found for a
sensor will only be plotted if they fall within the time window set by the Start Plotting
and Stop Plotting fields. The scale can be used to zoom in on an area of interest.
The scale value defines a box around the field Center Lat and Center Lon which
define the center of the box to be plotted. Positions found that do not fall within the
area defined by the Center Lat, Center Lon and Scale fields will not be displayed.
The filename that contains the binary data that is to be plotted is dispiayed in the field
labeled Filename. If this is not the file you wish to plot from, select this field and you
will be presented the standard file dialog box that will allow you to specify another
filename. The post plotting utility can only plot one sensor at a time. Select the sensor
to plot from the spin list labeled Plot Track From. To select the destination of the plot
information select either the Screen or Plotter check box. If the plotter is selected and
there is no serial port dedicated to the plotter, you will be prompted to select a port for
the plotter. When the above form is complete, select the Okay button to plot the data
or select the Cancel button to abort the operation.

The Display Menu
The Display Menu contains selections for controlling both the main graphic drawing

area and the side panel display. See Figure 36.

Lines
Video

Tracking

Set Scale

Set Center
Graphics Display
Side Panel Display
Miscellaneous

Figure 36.The Display Menu
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Coastline
The Coastline menu selection allows the operator to select from a set of vectored
coastline files. See Figure 37.

| Select Coastline File
PALOSVRD.CST

PALOSYRD.CST
SFBAY_C.CST
SFBAY._N.CST

SFBAY_S.CST

NSLOPE_1.CST
NSLOPE_2.CST
NSLOPE_3.CST

Figure 37.Coastline File Selection

The coastline file format is documented in Appendix C. To select a coastline for
display, select the name of the coastline file from the scrollable list and press the Okay
button. The display of the coastline may be overridden by the Display/Miscellaneous
form member for Draw Coastline. if Draw Coastline is not enabled, then no coastline
will be drawn even if one has been selected using the Coastline selection option.

Lines

The Lines menu selection allows the operator to control exactly which lines will be
displayed on the graphical display. When this option is selected the operator will be
presented a scrollable checklist form that allows flagging of some, all or none of the
current lines for display. See Figure 38.
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Figure 38.Line Display Control

To toggle a line for display, seiect the name of that line by clicking the mouse on it.
Line names that are checked will be displayed. To view all of the survey lines, select
the All button. To display none of the lines, select the None button. To abort this form
select the Cancel button. To update the display with the newly selected lines select
the Okay button.

Video

The Video menu selection will allow the operator to create and open a window on the
main display for displaying real-time video. This option requires a LiveWindows video
board to operate. The first time that the video menu selection is pressed a small video
window will open in the lower left corner of the display. The video window may be
moved by dragging the window with the mouse. The video window may be resized by
clicking on its lower right-hand corner. A smalier highlighted area on the border will
appear. This is a handle that can be stretched in the X and Y axes. By selecting the
video menu again, the operator will be presented with a form of video controls for
changing the appearance of the video image. See Figure 39.
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Figure 39.Video Control

There are five slide bar controls on the Video Control form for changing the Voiume,
Brightness, Contrast, Color and Hue of the video image. To modify any of the
settings, drag the control indicator to the left or right to decrease or increase the
control. There are 3 check boxes that control the input source of the video window.
Source 1 is the onboard TV tuner. Source 2 selects the external video and audio input
jack on the back of the LiveWindows board. Source 3 is for other Chips and
Technologies PC Video (8001 or S001A) compatible boards that have a third video
source. YoNav is configured to accept only NTSC video format although the hardware
will support the European PAL format. The Video Control form contains a spin list
control for changing channels on the onboard TV tuner. This control has no effect on
the other sources of video input.

Tracking :
Occasionally, when switching between one sensor and another, the operator will want

to look at the performance of the other sensor. The Tracking display option allows the
operator to graphically view the track of sensors other than the primary sensor before
actually making the switch. When the Tracking option is chosen, the operator is
presented with a scrollable checklist of all the available sensors that can produce a
track. See Figure 40.

43



Select Sensors for Main Display

COM2 Trimble NavTraki|
COM3 Magnavox MX1187
COM4 Ashtech GPS

Figure 40.Video Control

Check the sensors that you want to display. More than one may be chosen. There is
no need to check the current sensor since it will always be tracked automatically. Each
additional sensor will be displayed in a different color from the primary sensor.

Set Scale

The Set Scale menu provides a sub menu of two options to change the graphic screen
scale. The scale may also be changed by using the PgUp and PgDn keys. See
Appendix D.

Choose Scale

The Choose Scale menu presents the user with a spin list of possible scale values to
choose from. Select the desired scale and press the Okay button to activate it. To
abort this form use the Cancel button. See Figure 41.
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Choose Scale

Scale in Meters

Figure 41.Choosing the Scale

Window Zoom

The Window Zoom option allows the user to draw a box around the area of zoom
using the mouse cursor. This feature can also be implemented by a quick double click
of the mouse any where in the graphical drawing area. To abort the Window Zoom
function press the Esc key. Note that the graphics are not updated until the drop down
menus have been removed. For this reason, it is probably easier to use the double-
click method of zoom than the menu pick method.

&t Qenter

The Set Center function allows the user to center the graphics display about a point
selected with the cursor. When this item is selected, the message window at the
bottom of the display will tell the operator to click on the new center of the display.
When this operation is performed, the screen will be redrawn centered around the
selected point. Note that the screen will not be redrawn untii the pull down menus have
been closed. Note that the default option for the graphics display is to always keep the
ship in view on the screen. When this mode is active, if you try to set the center to a
location that would force the ship off the screen, the set center operation will be
canceled and the ship will remain in view. Auto ship centering can be overridden by
using the Display/Miscellaneous selection. The Home key can also be used to select
the new screen center, see Appendix D.

Graphics Display
The Graphics Display function allows the user to select the graphics display for the

main drawing area. See Figure 42.
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Pick Display Type

ivﬂglan View|
i‘ E_L_ine Following

Figure 42.Graphics Display Type

There are four possible options for the graphics display type of which only two are
finished in this release. The Plan View check box will display a plan view of the ship,
tracklines, sampling sites and historical ship track. The Range Reduction selection
will display the results of the least squares reduction when using the DelNorte 540 or
other ranging system. This form is primarily a programmer’s debuggmg feature and will
probably be removed in future releases.

The Line Following and Polar displays are not yet implemented.

Side Panel Display
The Side Panel Display function allows the user to select the type of information to

display on the side panel. See Figure 43.

_Side Panel Displa

| [v}JLine Info

i Egite Info
| gkagl fgancell

Figure 43.Side Panel Display




For line steering information choose the Line Info check box. For sampling site
steering information choose the Site Info check box. Select the Okay button to activate
the change or the Cancel button to abort.

laneous
The Miscellaneous provides some general display features. See Figure 44.

Miscellaneous Options

Keep Ship Centered
Draw Ship To Scale
Umsplg_g Coastline

Fix Symbology

! &ﬁ got‘ !“l Cross | :rﬁ Other |
ngayl gr_t_ancell

Figure 44 Miscellaneous Display Options

The check box labeled Keep Ship Centered when checked forces the ship to always
stay in the graphical viewing area. To view objects that are in another operating area,
uncheck this box and zoom in on the new area. Checking the box labeled Draw Ship
to Scale forces the ship to be drawn relative to the current viewing scale. So at large
scales the ship will appear very small and at small scales very large. Uncheck this box
to view the ship at a fixed size regardless of the scale. Checking the box labeled
Display Coastline causes the current coastline file to be drawn during screen refresh
operations. On slower systems this may take 1-5 seconds. If the coastline is not
needed, this option is better left unchecked. There is a group of three check boxes
labeled Fix Symboiogy. These boxes determine the shape of the symbol to be piaced
on the screen at each ship fix. Check the symbol that suits your display the best. To
update YoNav with these changes, select the Okay button. To abort this form select
the Cancel button.
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ig Menu
The Config menu provides functions to set up global parameters such as coordinate
system and display units. There are also provisions for configuring a specialized depth
correction feature and bridge display control options. An optional optically isolated
relay board may also be configure to update analog recorders at user specified
intervals.

e tem
The Coordinate System function aliows the user to select the coordinate system for all
system coordinate displays. See Figure 45.

Select Coordinate Q

{ v [ Latitude/Longitude

UTM|
] Okay ' l Cancell

Figure 45.Coordinate System Selection

Select the coordinate system of choice and press the Okay button to activate it or the
Cancel button to abort it.

Units

The Units function allows the user to select the angular units for latitude and longitude
as well as the decimal accuracy displayed for all floating point numbers. See Figure
46.
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Figure 46.Units Selection

Select the desired display format units and press the Okay button to accept or the
Cancel button to abort. Note that the units feature is for display and printouts only and
does not affect the accuracy of the recorded data.

Depth Correction
The Depth Correction function is a very specialized option for correcting the depth

value received from the Raytheon PDD Bathy Digitizer. This option allows the operator
to optionally correct the depth using an operator supplied sound velocity. See Figure
47.

PDD Depth Correction

lleepth Correction Enabled

PSR
Sound Velocity m/s |1464.80|
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